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Purpose

The Attorney’s User Guide provides instructions on how to use the Case Management 
Electronic Case Files (CM/ECF) system to file documents with the court. This guide also 
provides enough information to use PACER to view and retrieve docket sheets and 
documents. If more information is needed for PACER than what is provided in this guide, 
then go to the following website and review the resources provided there:

Audience

The CM/ECF Attorney’s User Guide is intended for attorneys and users that file documents 
electronically to the United States District Court for the Southern District of Texas. This 
information may not be accurate for other districts.

Notations

The following notations are used throughout this guide:

Notation Description

This image indicates a warning message. The text that follows is in red. The 
message identifies activities that will or could cause the application to not func-
tion as expected or required.

This image indicates that important information is being provided that the 
reader should be aware of when using the application. The application will con-
tinue to function properly whether the information provided is used or not.

The light bulb indicates a tip or trick is being provided on how to use the appli-
cation to its full potential.

plain text The base font for the manual is Palatino Linotype size 11.

bolded text Dialog names are bolded.

blue text Cross references to another topic in the manual are bolded and blue. Click the 
bolded, blue text to move to the cross-referenced information.

green text Image call outs are bolded and dark green in a smaller size of the base font.
i



CM/ECF Attorney’s User Guide Preface
text Menu items, button names, and the dialog’s field/option names are in the Times 
New Roman font, size 11, bolded, and italicized.

text » text Menu selection involving submenus use the » symbol. For example to select 
Print from the File menu, the manual will use File » Print.

value
command

When a value or command must be enter from the keyboard, the information is 
in the Arial font, size 10 and bolded.

value repvalue When the value/command contains a component that must be replaced with a 
value pertinent to your situation, that replacement is italicized. Afterwards, an 
explanation will be given like the following: 
Where repvalue is replace with ____ for your court.

 directory path When a directory path or directory path and filename are provided, the informa-
tion is in the Arial font, size 10.

filename When a filename is provided without a directory path, the filename is in the 
Arial font, size 10 and bolded.

Notation Description
ii
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Introduction to CM/ECF
Chapter 1 – Introduction to CM/ECF

Purpose This chapter provides information that an attorney needs before getting started 
using CM/ECF, including where to get help, definition of terms, system 
requirements, and other CM/ECF and PACER capabilities and registration 
information.

Chapter Topics The following topics are covered in this chapter:

• Overview, page 1 – 2

• Help Desk, page 1 – 2

• Definitions, page 1 – 2

• Systems Requirements, page 1 – 4

• CM/ECF System Capabilities, page 1 – 5

• PACER Registration, page 1 – 5
1 – 1
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Overview
Overview

This guide provides instructions on how to use the Case Management Electronic Case Files 
(CM/ECF) system to file documents with the court, or to view and retrieve docket sheets and 
documents. The screen shots that display may differ slightly as you electronically file your 
documents, due to enhancements or upgrades. 

All users should have a working knowledge of Microsoft Internet Explorer and Adobe 
Acrobat. For questions regarding these applications, please refer to their user manuals.

Before electronically filing, you should be thoroughly familiar with the following documents:

• Administrative Procedures for Electronic Filing in Civil and Criminal Cases

http://www.txs.uscourts.gov/attorneys/cmecf/district/admcvcrproc.pdf

• Local Rules

http://www.txs.uscourts.gov/district/rulesproc/dclclrl2009.pdf

Help Desk

For questions regarding this guide, CM/ECF, or filing pleadings/documents, you can contact 
our CM/ECF Help Desk at district_ecf_helpdesk@txs.uscourts.gov or by phone at (866) 358-
6201. Our support hours are Monday through Friday 8:00 a.m. to 5:00 p.m. CST. When 
sending email, please include the case number.

Definitions

The following definitions are used throughout this guide:

Court For purposes of this guide, court is the United States District Court 
for the Southern District of Texas.

Electronic Filing The uploading of a pleading or document, in PDF format, directly 
from the registered user’s computer, using the Court’s Internet-based 
system to file that pleading or document in the Court’s case file. Send-
ing a document or pleading to the Court via e-mail as an attachment 
does not constitute “electronic filing.”
1 – 2
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Electronic Filing  
System

The Court’s automated system that receives and stores documents 
which were filed in electronic form. The program is part of CM/ECF, 
which was developed for the Federal Judiciary by the Administrative 
Office of the United States Courts.

Filing User A person registered to file documents electronically with the Court. 
Filing users must be one of the following:

• Admitted to practice before the United States District Court for 
the Southern District of Texas and a member in good standing 
of the Court. 

• Admitted pro hac vice.

• Authorized to represent the United States of America.

OR

• Proceeding as a nonprisoner pro se litigant approved as a filing 
user by the Court. 

A filing user must receive a login and password from the District to 
use the Court’s electronic filing system.

Hyperlink A reference in a hypertext document that refers to another document 
or other resource. It is similar to a citation in literature. However, 
combined with a data network and suitable access protocol, it can be 
used to retrieve the resource referenced. A hyperlink document can 
be saved, viewed, or displayed as part of the referencing document.

Notice of Electronic 
Filing (NEF)

An electronic notice that is automatically generated by the electronic 
filing system at the time a document is docketed. The NEF includes 
the time of filing and docketing, the name of the party and filing user 
filing the document, the type of document, the text of the docket 
entry, the name of the party, and filing user receiving the notice. If a 
document is attached to the docket entry, the NEF contains a hyper-
link to the filed document allowing recipients to retrieve the docu-
ment.

PACER Public Access to Court Electronic Records (PACER) is an automated 
system allowing a user to view, print, and download Court docket 
information over the Internet. Users must register with the PACER 
Service Center at http://pacer.psc.uscourts.gov/.

Portable Document 
Format (PDF)

A document file that was either created with a word processor or was 
originally a paper document scanned and converted to a PDF file. 
Documents must be converted into PDF format to be filed electroni-
cally with the Court. These files have the file extension .pdf.
1 – 3
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Systems Requirements
Systems Requirements

The hardware and software required to electronically file, view, and retrieve case documents 
are the following:

• A computer running a standard platform such as Windows or a Macintosh operating 
system.

• Adobe Acrobat or other software capable of converting documents from a word 
processor format to the portable document format (PDF)

• A PDF-compatible word processor like Macintosh or Windows based versions of 
Microsoft WordPerfect and Word.

• A compatible Internet browser.

Mozilla Firefox version 24.0 was used for all screen captures in this manual.

• Access to a scanner if non-computerized documents need to be imaged.

A scanner should only be used for documents that cannot be produced 
electronically. Scanned documents lessen the level of service we provide by 
slowing down the entire system. We are moving away from the utilization of 
scanned documents inside the Court and are asking you to do the same when 
possible.

Pro Se Litigant A person who represents oneself in a Court proceeding without the 
assistance of an attorney.

Scanned 
Documents

These are the paper documents that are converted to PDF via a 
scanner or multifunction copier or scanner, as opposed to converting 
an electronic document from a word processor. When scanning paper 
documents that will subsequently be filed electronically, filing users 
should configure their scanners for 300 dpi and black and white 
scanning (rather than color scanning). 

Traditional Filing/
Traditionally Filed

This is also referred to as “conventional filing,” which is submitting 
paper copies of pleadings and documents in the traditional or 
conventional manner either in person, by courier, or via United States 
Postal Service.
1 – 4
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CM/ECF System Capabilities

The electronic filing system allows registered participants with Internet accounts and 
Internet Explorer software to perform the following functions:

• Open the Court’s web page.

• View or download the most recent version of the User’s Guide.

• Electronically file pleadings and documents in actual (live) cases.

• Self-train on PACER web-based Tutorial.

• View official docket sheets and documents associated with cases.

• View various reports (e.g., Cases Filed Report, Calendar) for cases that were filed 
electronically.

PACER Registration

CM/ECF users must have a PACER account with the Court in order to use the Query and 
Report features of the CM/ECF system. If you do not have a PACER login, contact the PACER 
Service Center to establish an account. You may call the PACER Service Center at (800) 676-
6856 for information or to register for an account. Also, you may register for PACER online at  
http://pacer.psc.uscourts.gov/register.html. A link to PACER’s site is provided on the Court’s 
website.
1 – 5
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Working with PDF Files
Chapter 2 – Working with PDF Files

Purpose This chapter provides information on the PDF file format, including how to view 
them and convert Microsoft Word and WordPerfect files to this format.

Chapter Topics The following topics are covered in this chapter:

• Setting Up Adobe Acrobat, page 2 – 2

• Portable Document Format (PDF), page 2 – 2

• How to View PDF Files, page 2 – 2

• How to Convert Documents to the PDF Format, page 2 – 4

• CM/ECF Limitation on PDF Document Size, page 2 – 5

• Common Mistakes When Filing PDF Documents, page 2 – 5

• Email Notification of Filed PDF Documents, page 2 – 6

• Certificate of Service, page 2 – 6
2 – 1
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Setting Up Adobe Acrobat
Setting Up Adobe Acrobat

Users must set up Adobe’s Acrobat Reader or Adobe Acrobat Professional in order to view 
documents that have been electronically filed on the system. All pleadings must be filed in 
PDF format. When installing these products, please review and follow Adobe’s directions to 
use the product effectively.

Portable Document Format (PDF)

Only PDF (Portable Document Format) documents may be filed with the Court using the 
CM/ECF system. Before sending the file to the Court, users should preview the PDF 
formatted document to ensure that it appears in its entirety and in the proper format. The 
PDF document should not include any embedded files like scripts, files, and executables. 
Filings with these embedded attachments will be rejected by CM/ECF. For information on 
PDF size limitations in CM/ECF, see page 2 – 5.

How to View PDF Files

All PDF files can be viewed in Adobe Acrobat Reader or Adobe Acrobat Professional. There 
are two access methods upon which you can view the files.

Directly Selecting PDF Files

The fastest method for viewing a PDF file is to select the file in Explorer. When the Adobe 
Acrobat software was installed, a file association to the PDF file format should have 
automatically been set. This association allows you to double-click the PDF file to open it 
directly in Acrobat.

If the file association does not work:

1. Right-click any PDF file.

2. Select Open with » Choose default program.
2 – 2
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How to View PDF Files
The Open with dialog displays.

3. Select the Adobe Acrobat program.

4. Check the box Always use the selected program to open this kind of file.

5. Click OK.

The file association is now set for all future selections.

Selecting PDF Files within Adobe Acrobat

To select the PDF within Adobe Acrobat;

1. Open Adobe Acrobat Reader or Adobe Acrobat Professional.

2. Select File » Open.

The Windows Open dialog displays.

3. Navigate to and select the desired PDF file.

4. Click Open.

The PDF file now displays in Adobe Acrobat.
2 – 3
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Viewing Options

Once the PDF displays, there are several viewing options available depending on your 
version of Adobe Acrobat Reader or Adobe Acrobat Professional. To learn more about the 
viewing options available to you:

• Select the View menu and review the items it contains.

• Hover your cursor over the toolbar for a description of each toolbar icon.

• Select Help » Adobe Acrobat and review the online help topic Workspace » Viewing PDF 
pages.

How to Convert Documents to the PDF Format

You must convert your documents to PDF format before submitting them to the Court’s  
CM/ECF system. Both Microsoft Word and WordPerfect create text searchable PDF files as 
follows:

1. Open the docu-
ment in Word 
or WordPerfect.

2. Select File tab 
and then the 
Print item.

The printing 
window 
displays.

3. For Word’s 
printer or 
WordPerfect’s 
destination 
name, select 
Adobe PDF.
2 – 4
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4. Click the Home tab to return to the document.

The document automatically adjusts to the Adobe PDF print driver settings.

5. Scroll through the document, to verify or change the formatting and location of 
section headings.

6. Select File tab and then the Print item.

The printing window displays again.

7. Click the Print button.

The Save PDF File As window displays.

8. Navigate to the folder where the PDF file should be saved.

9. Enter a file name and click Save.

A text searchable PDF file is created.

CM/ECF Limitation on PDF Document Size

The current size limitation that CM/ECF allows for electronically filed documents, including 
exhibits or attachments, is 5 megabytes. While this limit will not likely affect electronically 
created documents, in the case of imaged documents, it would be the equivalent of 
approximately 75 pages.

It is the responsibility of the filing user to ensure that PDF files meet the file size restrictions. 
Larger electronic documents must be divided into smaller PDF files. For example, an eight 
megabyte PDF file could be divided into one 5 megabyte and one 3 megabyte file.

Common Mistakes When Filing PDF Documents

Some common mistakes made when filing PDF documents include:

• Selecting the wrong PDF file to attach to a docket entry.

• Selecting the wrong document type (i.e., the original document rather than the 
converted file with the .pdf extension).
2 – 5
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• Selecting the wrong docketing event from the CM/ECF menus.

• Entering the wrong case number and not discovering the error before completing the 
transaction.

The CM/ECF system does not permit you, or the clerk’s office, to substitute or remove a 
misfiled PDF document after it has been submitted and electronically delivered to the court. 
Only the presiding judge may order the unfiling of a document once it has been filed. So, 
please be careful to avoid these common mistakes.

If a mistake has been made, contact the CM/ECF Help Desk (see page 1 – 2). When calling, 
you must provide the case number and document number(s) for the docket entry or entries 
requiring correction. 

Email Notification of Filed PDF Documents

After electronically filing a PDF document, the CM/ECF system sends a Notice of Electronic 
filing (NEF) to the designated attorneys and parties who have supplied their email addresses 
to the Court. The NEF also displays the names and addresses of the individuals who will not 
be electronically notified of the filing.

It is the filer's responsibility to serve hard copies of the document and the NEF to 
attorneys and parties who are not set up for electronic notification.

Individuals who receive the NEF are permitted one "free look" at the document by clicking 
on the associated hyperlinked document number embedded in the NEF. The filer is 
permitted one free look at the document to verify that it was properly docketed. Pursuant to 
guidelines set by the Administrative Office of the U. S. Courts, the free look is available only 
once within the 15 day grace period from the date of filing.

Subsequent retrieval of the case docket sheet and document from CM/ECF must be made 
through your PACER account and is subject to regular PACER fees.

Certificate of Service

A certificate of service must be included with all filed PDF documents reflecting that service 
on known filing users will be accomplished through the NEF and indicating the manner of 
service on any party who is not a filing user. Refer to Local Rules LR 5.3.
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Chapter 3 – Getting Started in CM/ECF

Purpose This chapter describes some basic CM/ECF information, including how to log in, 
the menu items, what buttons are available for manipulating web pages, and 
finally how to verify the correct case number and your CM/ECF transactions.

Chapter Topics The following topics are covered in this chapter:

• Accessing the CM/ECF System, page 3 – 2

• The CM/ECF Menu Bar, page 3 – 7

• Manipulating Web Pages, page 3 – 8

• Verifying Case Number while Docketing, page 3 – 8

• Reviewing Your CM/ECF Transactions, page 3 – 9
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Accessing the CM/ECF System

Accessing CM/ECF not only involves logging into CM/ECF, but for some of its features, 
requires users to also log into PACER.

Logging Into CM/ECF

Users can log into the CM/ECF system via the Internet as follows:

1. Enter the following URL address into your browser:

http://www.txs.uscourts.gov/

2. Under Quick Links, click the District Electronic Case Filings (ECF) link.

The Attorney Admissions web page displays.

3. Click the Live District CM/ECF link.

The Live CM/ECF system displays.

4. Click the Southern District of Texas - Document Filing System link.
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The ECF Login page displays.

5. Either:

• Enter your CM/ECF login and password if you plan on filing documents.

OR

• Enter your PACER login and password if you plan on viewing and querying 
information.

Login names and passwords are case sensitive. 

6. Read the notice boxed in red.

7. Mark the check box within the red boxed-in notice.
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8. Click Login to have the login and password validated.

If a valid login and password combination was entered, then the system displays its 
main web page (below assumes the CM/ECF information was entered).  

You can choose any menu item from the blue menu bar along the top of the web 
page.

The date and time of your last CM/ECF log in appears at the bottom of the web 
page. You should review this each time you log in. If you suspect your last login 
date and time are incorrect, or that an unauthorized party is using your login 
and password, contact the court’s Help Desk immediately (page 1 – 2).

If an invalid login and password combination was entered, then the system responds 
with the following error message:

9. If this occurs, click Back.

The ECF Login page displays again.

10. Return to step 5 and re-enter the login and password.
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Logging Into PACER

During your CM/ECF session, if you deviate from either electronically filing a document or 
maintaining your user account by selecting the Query or Report menus, the system prompts 
you for your PACER login information.

1. Select Query from CM/ECF’s web page.

The PACER Login page displays.

WARNING:  At the bottom of the PACER Login page is a Notice detailing the 
charges for using PACER.
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2. Enter your PACER login and password.

3. (optional) Enter a client code.

The Client code field is an optional field which allows PACER functions to be 
tracked. It can contain up to 32 characters. If a code is entered, then it is listed on the 
billing statement generated by the PACER Service Center; otherwise, it is not on the 
statement. Because this code is optional, it must be enforced within a user’s office. 

4. (optional) Select Make this my default PACER login check box.

Choosing this check box links your PACER information to your CM/ECF login and 
password. This means you will not be required to enter you PACER information 
again while working in CM/ECF.

For information on breaking the link between the CM/ECF and PACER login 
information, see the PACER User Guide.

5. Click Login to have PACER validate the login and password.

If a valid login and password combination was entered, then CM/ECF continues to 
the next web page in the process.

If an invalid combination was entered, then the system responds with the following 
error message:

6. If this occurs, click Back.

The PACER Login page displays again.

7. Return to step 2 and re-enter the login and password.
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CM/ECF provides the following menu items/features in the blue menu bar located at the top 
of every web page.

Menu Description

Civil Files electronically all civil case pleadings, motions, and other court documents.

Criminal Files electronically all criminal case pleadings, motions, and other court documents.

Query Performs queries in CM/ECF by specific case number, party name, or nature of suit 
to retrieve documents that are relevant to the case. 

You must log into PACER before you can query CM/ECF.

Reports Retrieves docket sheets and cases-filed reports.

You must log into PACER before retrieving these reports.

Utilities Displays your personal CM/ECF transaction log and allows you to maintain your 
CM/ECF account information.

Search Searches through the CM/ECF menus and events for the specific text you enter.

Logout Exits CM/ECF and prevents further filing with your password until the next time you 
log in.
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The following buttons can be used to manipulate the CM/ECF web pages:

Verifying Case Number while Docketing

As you electronically file, each window displays a case number in the upper left-hand corner. 
This ensures that you are docketing to the correct case. 

If you are uncertain this is the correct case, right-click on the case number link and select 
Open in New Window to run a docket sheet for that case. You will be prompted to enter your 
PACER login and password (see page 3 – 5) before viewing the docket sheet. Once you have 
verified that this is the correct case, close the new window and return to the window you 
were previously on.

Buttons Description

Moves the user back one web page. Internet Explorer’s back button is blue, while 
Firefox’s is slightly larger and green. Both are located in the browser’s upper-left corner. 
In both cases, you should use them to go back and correct an entry made on a previous 
web page. 

If you discover an error after the document is transmitted, contact the 
Help desk.

Clears all characters that have been entered and selections that have been made on 
the web page (i.e., it restores the web page back to its starting pointing).

Accepts all input and selections made, and then displays the next 
CM/ECF web page, if any. 

Case number
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Reviewing Your CM/ECF Transactions

If you need to check what you have done in CM/ECF, select the Utilities menu and then the 
View Your Transaction Log link (see page 7 – 4). This feature allows you to review all the 
transactions CM/ECF has processed with your login and password.

Besides just reviewing your transactions, you can use the transaction log to confirm if 
someone is using your login and password without your permission. If you suspect someone 
is using your information, immediately contact the clerk’s office. The clerk’s office will assist 
you in changing your password. If you believe that a document has been improperly filed 
with the court under your signature (i.e., your login and password is your electronic 
signature), you need to take whatever action you deem appropriate. 
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Chapter 4 – Filing Documents Electronically

Purpose This chapter provides detailed instructions on opening a civil case and how to file 
motions in both civil and criminal cases.

Filing users should be thoroughly familiar with the document "Administrative 
Procedures for Electronic Filing in Civil and Criminal Cases" before filing 
electronically. You can find this document in the following location:

http://www.txs.uscourts.gov/attorneys/cmecf/district/admcvcrproc.pdf

Chapter Topics The following topics are covered in this chapter:

• Opening a Civil Case, page 4 – 2

• Filing a Motion in a Civil Case, page 4 – 20

• Filing a Motion in a Criminal Case, page 4 – 33
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Opening a Civil Case

This procedure describes the process for opening a civil case in CM/ECF. 

To open a civil case:

1. Log into CM/ECF (see page 3 – 2).

The CM/ECF main web page displays.

2. Select Civil from the menu bar.

The Civil Events page displays. 

3. Click the Civil Case - Unassigned link.
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The following Open Unassigned Civil Case page displays.

4. Read the contents of the page.

5. Click Next.

The Open Unassigned Civil Case page changes to enter summary information.

6. Select the appropriate office from the pull-down menu.
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7. Select either cv or mc for the case type.

The bi and md options are for Clerk’s office internal use only. Do not select 
them.

Do not enter a Lead case number or change the Association type.

8. (optional) Either:

• If it is a notice of removal, enter the other court name and number.

 OR

• If it is related to a pending case in the Southern District of Texas, check the 
Related cases check box.

9. Click Next.

The Open Unassigned Civil Case page changes to enter additional case information.

10. Enter the following information:

• Jurisdiction, Nature of suit, Cause of action, Origin, Jury demand, Class action, 
Demand ($000) in thousands of US dollars (i.e., the system automatically adds 
the zeroes for you), and County of the filing party is always required.

• Filter can be used to narrow the Cause of action and Nature of suit fields. If 
filing a contract case, type contract in the Filter field to limit the drop-down 
choices to only those which contain contract in the name. You can also type 
numbers into the Filter field.
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• Citizenship plaintiff and Citizenship defendant are only necessary for cases 
with jurisdiction based on diversity of citizenship.

• Fee status and Fee date select as appropriate.

• Arbitration code and Date transfer should always be left blank.

11. Click Next.

The Open Unassigned Civil Case page changes to enter the plaintiff’s name.

12. Enter the business name or last, first, and middle name of the plaintiff.

13. Click Search.

The Open Unassigned Civil Case page changes to list the search results.

14. Either:

• Select a name in the results list and click Select Party to verify their information 
before proceeding.

OR

• When the results list is empty, click Create New Party.
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The Open Unassigned Civil Case page changes. Below a new plaintiff is being 
added.

15. Enter the following plaintiff information:

• Change the Role to Plaintiff (pla:pty). The role defaults to defendant so you must 
make this change.

Leave all address information blank for represented parties.

• Enter the Party text if stated on the complaint (Example: Individually, Successor 
to, etc.).

16. Click Add Party.
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The plaintiff is added to the Open Unassigned Civil Case page.

17. If the plaintiff has an alias, do the following:

a. Click the icon to the right of the word Alias in the tree structure.

The Open Unassigned Civil Case page changes to allow searching for the plain-
tiff’s alias.

b. Enter the plaintiff’s alias.

c. Click Search.

The Open Unassigned Civil Case page changes to list the search results.
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d. Either:

• Select a name in the results list and click Select Alias to verify their 
information before proceeding.

OR

• When the results list is empty, click Create New Alias.

The Open Unassigned Civil Case page changes. Below a new alias is being 
added.

e. Click Add Alias.

The alias is added beneath the plaintiff's name.

18. Use the same procedure to add additional plaintiffs or defendants. (see steps 12 
through 17)

19. Click Add New Party.
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The additional parties are added to the Open Unassigned Civil Case page.

20. Add the remaining parties.

21. Click Create Case.

A Case Opening message displays.

22. Click Yes for the message.

23. Click Next to proceed.

The Open Unassigned Civil Case page changes to show the docket text.
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24. Click Next.

The Open Unassigned Civil Case page changes to show the case number.

25. Click on the Docket Lead Event? link.

The Complaints and Other Initiating Documents page displays.

26. Select the appropriate event for your situation from the drop-down menu.

The selected event is placed in the Selected Event text box.

27. Click Next.

The full case number displays.

28. Verify the case number.

29. Click Next.
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The Complaints and Other Initiating Documents page changes to provide the 
following message concerning summons.

30. Click Next.

The Complaints and Other Initiating Documents page changes to show all the 
parties in the case.

31. Select the name of the filer (i.e., plaintiff).

32. Click Next.
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The web page for making the association between the plaintiff and the attorney 
displays.

33. Click Next.

The Complaints and Other Initiating Documents page changes to show all of the 
parties in the case.

34. Either:

• Select the party that is being filed against (i.e., defendant).

OR

• Select the appropriate group.

35. Click Next.
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The Complaints and Other Initiating Documents page changes to select the PDF 
document and attachments.

It is imperative that you attach an electronic 
copy of the actual document when prompted 
by the system. Failure to do so causes 
CM/ECF to display the error message shown to 
the right.

36. For the Main Document, click Browse.

The Windows Choose File to Upload dialog displays.
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37. Navigate to and select the PDF to upload.

The selected PDF must meet CM/ECF size limitations (page 2 – 5).

You must select a PDF file. Selecting another file format causes CM/ECF to display 
the following error message after clicking the Next button:

If you receive this message, click the Back button and select a PDF formatted file.

38. (optional) Verify you selected the correct document by right-clicking it and selecting 
Open or Open with Acrobat (whichever is available). 

The PDF file opens in Acrobat. Once verified, close Acrobat.

39. Click Open.
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CM/ECF inserts the PDF file name and location in the Complaints and Other 
Initiating Documents page.

If there are no attachments to the document, skip to step 40. If there are attachments, 
continue to the next step. The procedure to add attachments is similar to adding the 
main document.

40. (optional) Add an attachment as follows:

a. For the attachment, click Browse.

The Windows Choose File Upload dialog displays.

b. Navigate to and select the PDF file to upload.

The PDF must meet CM/ECF size limitations (page 2 – 5).

c. Click Open.

CM/ECF inserts the PDF file name and location in the Complaints and Other Ini-
tiating Documents page. Notice that the space for the next attachment is automat-
ically added.
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d. You must:

• Use the Category pull-down menu to select the attachment type.

AND/OR

• Enter a clear and concise description for the attachment.

e. Return to step 39 a. for each attachment that must be added.

41. Click Next.

The Complaints and Other Initiating Documents page changes to ask a question to 
determine whether a fee is charged for the filing.

42. Answer either Y or N, which ever is appropriate for your situation.

43. Click Next.

If a fee is to be charged, the Complaints and Other Initiating Documents page 
changes to show the fee amount.

44. Click Next.

The Online Payment page displays.
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Payment by 
electronic check

Payment by 
credit or debit 
card
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45. Complete all required information for the payment.

After the payment, the case number and name displays.

46. Click Next to proceed.

The Complaints and Other Initiating Documents page changes to show you the 
final docket text and documents being filed.

47. Review the docket text and correct any errors by using the browser’s back button to 
find the page you need to change. 

This is the last opportunity to abort the CM/ECF filing, which can be done by 
clicking on any CM/ECF menu item or clicking the browser’s back button until 
you reach the beginning of the event.

48. Click Next.
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After processing, CM/ECF displays the Notice of Electronic Filing (NEF).

The NEF confirms that CM/ECF opened the case and that the parties were notified. It 
also displays the date and time of your transaction and the number that was 
assigned to your document. You should note this number on the document’s PDF 
file.

The system does not assign a Judge at this time. One will be assigned later via 
the clerk’s office.
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49. Select the browser’s Print icon to print the document receipt.

50. Select File » Save As to save the receipt to a file on your PC.

The NEF is your confirmation that the filing was accepted.

If you are not familiar with the email notifications of filed PDF documents and of the NEF, 
see page 2 – 6.

Filing a Motion in a Civil Case

This procedure describes the process for filing a motion in a civil case. The process is similar 
for filing other civil case pleadings in CM/ECF.

To file a motion in a civil case:

1. Log into CM/ECF (see page 3 – 2).

The CM/ECF main web page displays.
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2. Select Civil from the menu bar.

The Civil Events page displays. 

3. At the bottom of the page, click the Motions link.

The following Motions page displays.

4. Enter the number of the case for which you are filing a motion.

As you enter a case number, the Motions page changes to the following:

5. Click Find This Case.
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If the case number is found, the Motions page changes to the following and the Next 
button becomes available:

If the case number is not found, the Motions page changes to the following. You can 
click the Clear button to remove your entry and start over or correct the entry that is 
already there.

If CM/ECF finds multiple matches, the Motions page shows the following. After 
selecting which case you want, the Next button becomes available.

6. Click Next.
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The Motions page changes to select the motion type.

7. Either:

• Begin entering the event name in the text box to have CM/ECF automatically trim 
the list of available events.h

OR

• Use the scroll bar to locate the event you need.

8. Select the appropriate event from the Available Events listing.

The selected event determines which web pages CM/ECF displays. 
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The selected event is placed in the Selected Events text box.

To delete a selected event, click the event in the Selected Events text box.

9. Click Next.

The Motions page changes to designate the party or parties filing the document.

10. Highlight the name of the party or parties for whom you are filing the motion.

If you represent multiple defendants or plaintiffs, you can select more than one party 
by holding down the Ctrl key while making your selection.

11. Click Next.
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The Motions page changes to select the PDF document and attachment(s).

It is imperative that you attach an electronic 
copy of the actual pleading when prompted by 
the system. Failure to do so causes 
CM/ECF to display the error message shown to 
the right.

12. For the Main Document, click Browse.

The Windows Choose File to Upload dialog displays.

13. Navigate to and select the PDF file to upload.

The selected PDF must meet CM/ECF size limitations (page 2 – 5).
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You must select a PDF file. Selecting another file format causes CM/ECF to display 
the following error message after clicking the Next button:

If you receive this message, click the Back button and select a PDF formatted file.

14. (optional) Verify you selected the correct document by right-clicking it and selecting 
Open or Open with Acrobat (whichever is available). 

The PDF file opens in Acrobat. Once verified, close Acrobat.

15. Click Open.
4 – 26



CM/ECF Attorney’s User Guide Chapter 4 – Filing Documents Electronically
Filing a Motion in a Civil Case
CM/ECF inserts the PDF file name and location in the Motions page.

If there are no attachments to the motions, skip to step 17. If there are attachments, 
continue to the next step. The procedure to add attachments is similar to adding the 
main document. 

16. (optional) Add an attachment as follows:

a. For the attachment, click Browse.

The Windows Choose File to Upload dialog displays.

b. Navigate to and select the PDF file to upload.

The PDF must meet CM/ECF size limitations (page 2 – 5).

c. Click Open.

CM/ECF inserts the PDF file name and location in the Motions page. Notice that 
space for the next attachment is automatically added.
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d. You must:

• Use the Category pull-down menu to select the attachment type.

AND/OR

• Enter a clear and concise description for the attachment.

e. Return to step 16 a. for each attachment that must be added.

17. Click Next.

In our example, we are filing a motion for hearing on a Pending Summary Judgment 
motion. The Motions page changes to enter the type of hearing and to link the 
document (if appropriate).

18. In the text box, enter Motion.

If the document you are filing should link to another document, then continue to 
step 19. Otherwise, skip to step 23.

19. (optional) Select the check box to link the document.

The web page should look as follows.
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The Motions page changes to select the relating event category.

20. Select all categories in the text area using one of the following methods:

• Hold down the Ctrl key and drag your mouse from the first to the last item in the 
list to highlight all categories.

OR

• Highlight the first item in the list, go to the last item in the list, and then hold 
down the Shift key and click the last item.

21. Click Next.

The Motions page changes to select the event to which you are linking.

22. Select the MOTION for Summary Judgment event.

23. Click Next.
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The Motions page changes to show the docket date.

24. Click Next.

The Motions page changes to allow for changes to the docket text.

25. (optional) If applicable to your event, use the pull-down menu to select a value for 
your event.

26. Click Next.
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The Motions page changes to show the final docket text and documents being filed.

27. Review the docket text and correct any errors by using the browser’s back button to 
find the page you need to change. 

This is the last opportunity to abort the CM/ECF filing, which can be done by 
clicking on any CM/ECF menu item or clicking the browser’s back button until 
you reach the beginning of the event.

28. Click Next to file and docket the pleading.
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After processing, CM/ECF displays the Notice of Electronic Filing (NEF).

The NEF confirms that CM/ECF has registered your transaction and that the 
pleading is now an official Court document. It also displays the date and time of 
your transaction and the number that was assigned to your document(s). You should 
note the number(s) on the PDF file(s).

29. Select the browser’s Print icon to print the document receipt.
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30. Select File » Save As to save the receipt to a file on you PC.

The NEF is your confirmation that the filing was accepted.

If you are not familiar with email notifications, see page 2 – 6.

Filing a Motion in a Criminal Case

Filing users must electronically file certain criminal documents as sealed pursuant to 
the "Administrative Procedures for Electronic Filing in Civil and Criminal Cases". You 
can review this document in the following location: 
 

http://www.txs.uscourts.gov/attorneys/cmecf/district/admcvcrproc.pdf

This procedure describes the process for filing a motion in a criminal case. The process is 
similar for filing other criminal documents in CM/ECF.

To file a motion in a criminal case:

1. Log into CM/ECF (see page 3 – 2).

The CM/ECF main web page displays.
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2. Select Criminal from the menu bar.

The Criminal Events page displays. 

3. Under Motions and Related Filings, click the Motions link.

The following Motions page displays.

4. Enter the number of the case for which you are filing a motion.

As you enter a case number, the Motions page changes to the following:

5. Click Find This Case.
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If the case number is found, the Motions page changes to the following and the Next 
button becomes available.

If the case number is not found, the Motions page changes to the following. You can 
click the Clear button to remove your entry and start over or correct the entry that is 
already there.

Sealed cases are not available in CM/ECF. If you are absolutely sure you are 
entering the correct case number, then it is possible the case is sealed. Motions 
for sealed cases must be filed in the Clerk’s office.

When multiple case numbers match the one typed in (i.e., there are multiple 
defendants on the case), then the Motions page changes to the following. You can 
click in the check boxes to mark the defendants to which the filing relates. If it relates 
to all defendants, then select the case number without a defendant number but with 
et al at the end.

6. Click Next.
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The Motions page changes to designate the party or parties filing the document.

7. Highlight the name of the party or parties for whom you are filing the motion.

If you represent multiple defendants, you can select more than one party by holding 
down the Ctrl key while making your selection.

8. Click Next.

The Motions page changes to select the motion type.
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9. Either:

• Begin entering the event name in the text box to have CM/ECF automatically trim 
the list of available events.

OR

• Use the scroll bar to locate the event you need.

10. Select the appropriate event from the Available Events listing.

The selected event determines which web pages CM/ECF displays.

The selected event is placed in the Selected Events text box.

To delete a selected event, click the event in the Selected Events text box.
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11. Click Next.

The Motions page changes to select the PDF document and attachment(s).

It is imperative that you attach an electronic 
copy of the actual pleading when prompted by 
the system. Failure to do so causes 
CM/ECF to display the error message shown to 
the right.

12. For the Main Document, click Browse.

The Windows Choose File to Upload dialog displays.
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13. Navigate to and select the PDF file to upload.

The selected PDF must meet CM/ECF size limitations (page 2 – 5).

You must select a PDF file. Selecting another file format causes CM/ECF to display 
the following error message after clicking the Next button:

If you receive this message, click the Back button and select a PDF formatted file.

14. (optional) Verify you selected the correct document by right-clicking it and selecting 
Open or Open with Acrobat (whichever is available). 

The PDF file opens in Acrobat. Once verified, close Acrobat.

15. Click Open.
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CM/ECF inserts the PDF file name and location in the Motions page.

If there are no attachments to the motions, skip to step 19. If there are attachments, 
continue to the next step. The procedure to add attachments is similar to adding the 
main document. 

16. (optional) Add an attachment as follows:

a. For the attachment, click Browse.

The Windows Choose File to Upload dialog displays.

b. Navigate to and select the PDF file to upload.

The PDF must meet CM/ECF size limitations (page 2 – 5).

c. Click Open.

CM/ECF inserts the PDF file name and location in the Motions page. Notice that 
space for the next attachment is automatically added.
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d. You must:

• Use the Category pull-down menu to select the attachment type.

AND/OR

• Enter a clear and concise description for the attachment.

e. Return to step 18 a. for each attachment that must be added.

17. Click Next.

The Motions page changes to allow you to link the document.

18. (optional) Select the check box to link the document.

This example does not illustrate linking a document. If you want to make the link, 
select the check box and click Next. A listing of available events will display from 
which you can then select an event to which your document relates. 

An example of linking a document was shown for filing a motion on a civil case 
starting with Step 19 on page 4 – 28.
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19. Click Next.

The Motions page changes to allow for changes to the docket text.

20. (optional) If applicable, use the pull-down menu to select a value for your event.

21. (optional) If applicable, add text in the text box for your event. 

22. Click Next.
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The Motions page changes to show the final docket text and documents being filed.

23. Review the docket text and correct any errors by using the browser’s back button to 
find the page you need to change. 

This is the last opportunity to abort the CM/ECF filing, which can be done by 
clicking on any CM/ECF menu item or clicking the browser’s back button until 
you reach the beginning of the event.

24. Click Next to file and docket the pleading.
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After processing, CM/ECF displays the Notice of Electronic Filing (NEF).
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The NEF confirms that CM/ECF has registered your transaction and that the motion 
is now an official Court document. It also displays the date and time of your 
transaction and the number that was assigned to your document(s). You should note 
the number(s) on the PDF file(s).

25. Select the browser’s Print icon to print the document receipt.

26. Select File » Save As to save the receipt to a file on you PC.

The NEF is your confirmation that the filing was accepted.

If you are not familiar with email notifications, see page 2 – 6.
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Purpose This chapter provides information on how you can query the CM/ECF database 
for information. Included are some sample queries to help you get started.

Chapter Topics The following topics are covered in this chapter:

• Accessing Query Mode, page 5 – 2

• Sample Queries, page 5 – 3

• Case Query Page, page 5 – 9
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Accessing Query Mode

CM/ECF allows registered participants to query its system for specific case information. 

To enter the query mode of CM/ECF:

1. Select Query from the menu bar.

The PACER Login page displays.

2. Enter your PACER login and password (see page 3 – 5 for instructions).
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After a successful PACER login, CM/ECF displays the Query page.

Sample Queries

The following are but a few sample queries to get you started using the Query page. They are 
not meant to be an all inclusive list.

No Search Criteria

Even though the Run Query button is immediately available, clicking it before entering 
criteria for the query produces the following error messages:

If you receive this message, click your browser’s back button to return to the Query page. 
Afterwards, enter some criteria before clicking the Run Query button again.
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Search by Case Number

To search CM/ECF based on a case number:

1. Enter your case number.

The Query page changes to make the Run Query button unavailable and to include a 
button for finding the case.

2. Click Find This Case.

As previously illustrated when filing documents, CM/ECF will let you know if the 
case number is found, not found, or if multiple case numbers match your entry.

The Run Query button becomes available again after a unique case number is found 
or after you select a case or cases from the matched listing.

You can fine tune your query by adding more criteria on the Query page.
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3. Click Run Query.

A Query page displays listing the case information you can view. 

From this page you can click on the information you want to see. For further details on this 
page, see “Case Query Page” on page 5 – 9.
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Search by Name

To search CM/ECF based on a party or attorney name:

1. Enter the last name of the party (or attorney) in the appropriate field.

2. Click Run Query.
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If more than one person with that name exits in the CM/ECF database, a page 
displays listing all the matches.

3. Click on the party name you need.

If the individual is a party to more than one case, CM/ECF displays a page listing all 
of the cases that party is associated with.

4. Click on the appropriate case number.

A query page that is similar to the Query page that displayed for the case number query 
appears. For further details on this page, see “Case Query Page” on page 5 – 9.
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Search by Nature of Suit

To search CM/ECF based on the nature of suit:

1. Select the nature of the suit from the pull-down menu.

2. Click Run Query.

A message displays stating that the search could produce many records. It is 
suggested that a date range be placed on these kind of searches to reduce the number 
of records found.

3. Click Cancel to return to the Query page.

4. Enter a date range for the search.

5. Click Run Query.
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With input in the date fields, the message concerning the number of records does not 
display. Instead, CM/ECF displays a list of cases matching the date range and nature 
of suit.

6. Click on the appropriate case number.

A query page that is similar to the Query page that displayed for the case number query 
appears. For further details on this page, see below.

Case Query Page

Once you have used CM/ECF query mode to find the case you need, the following Query 
page displays. 
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At the top of the page CM/ECF displays the case number, case style, presiding judge, date 
that the initial claim was filed or charging document was filed. If the case is closed it will also 
list the terminated date. You can choose specific case information from a large list of query 
options by simply clicking on the appropriate hyperlink name.

The following are but a few samples of the type of information you can view. They are not 
meant to be an all inclusive list.

Attorney Information

To obtain attorney information, click the Attorney link. CM/ECF displays the names, 
addresses, and telephone numbers of the attorneys who represent each of the parties in the 
case.
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Case Summary Information

To obtain summary information on the case, click the Case Summary link. CM/ECF displays a 
summary of the current case.
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Case Query Page
Deadlines/Hearings Information

To obtain information on the deadlines and hearings on the case:

1. Click the Deadlines/Hearings link.

The page shown to the right displays allowing you to 
query CM/ECF to obtain hearings and other schedule 
deadlines. 

2. Use the drop-down menus to select how the 
information should be sorted.

3. (optional) Select whether to include pending and/or 
terminated/satisfied deadlines/hearings.

4. Click Run Query.

The Deadlines/Hearings page sorts and displays the deadlines and hearings per your 
selection.

Clicking on a blue underlined document number causes CM/ECF to display that document 
when you have permissions to view it. Clicking on a gray sphere causes CM/ECF to display 
the docket information and related docket entries for the hearing you selected.
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Docket Information

To obtain a docket sheet:

1. Click the Docket Report link.

The Docket Sheet page displays allowing you to decide what CM/ECF should 
include on the docket sheet report.

Leaving the range fields blank causes CM/ECF to display the entire docket 
sheet.

2. (optional) Select a date range for the report.

3. (optional) Select a range of docketing numbers.

4. (optional) Mark the options you wish to include on the docket sheet.

Parties and counsel and Terminated parties are selected by default.

5. (optional) Change any other options on the page as you deem appropriate.

6. Click Run Report.
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CM/ECF runs and displays your customized docket sheet.

Clicking on a blue underlined 
document number causes  
CM/ECF to display that 
document when you have 
permissions to view it. Clicking 
on a gray sphere causes CM/ECF 
to display the Notice of 
Electronic Filing (NEF).
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Purpose This chapter provides information on how to access and run the reports provided 
by CM/ECF.

Chapter Topics The following topics are covered in this chapter:

• Accessing the Reports, page 6 – 2

• Sample Reports, page 6 – 3
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Accessing the Reports

To access the reports available in CM/ECF

1. Select Reports from the menu bar.

CM/ECF displays the Reports page.

2. Click the report link for the report you want to run.

The following reports require you to log into PACER:

• Docket Sheet

• Civil Cases

• Judgment Index

• Criminal Cases

3. If the PACER Login page displays, enter your PACER login and password (see page 
3 – 5 for instructions).

What displays next depends on the selected report. For more information, see the sample 
reports section that follows.
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Sample Reports

The following are sample reports that you can run from CM/ECF.

Docket Sheet

To run a docket sheet report:

1. Click the Docket Sheet link.

The PACER Login page displays.

2. Enter your PACER login and password (see page 3 – 5 for instructions).

After a successful PACER login, CM/ECF displays the Docket Sheet page. 

3. Enter the case number for the docket sheet you want to view.
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4. The Docket Sheet page changes to include a button for finding the case.

5. Click Find This Case.

As previously illustrated when filing documents, CM/ECF will let you know if the 
case number is found, not found, or if multiple case numbers match your entry.

The Run Report button becomes available after a unique case number is found or 
after you select a case from the matched listing.

6. (optional) Customize your docket sheet by designating:

• A document range. (Leaving the documents blank means to include all of them.)

• The items to include. (Parties and counsel and Terminated parties are selected 
by default.)

• Document, format, and sort by options.

7. Click Run Report.
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CM/ECF runs and displays your customized docket sheet.

Clicking on a blue underlined 
document number causes CM/ECF 
to display that document when you 
have permissions to view it. If you 
chose Links to Notices of Electronic 
Filing, then clicking on a gray 
sphere causes CM/ECF to display 
the Notice of Electronic Filing 
(NEF).
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Civil Cases

To run a civil cases report:

WARNING:  This report queries ALL civil cases for information that matches your 
criteria. Therefore your criteria could produce many pages of information for which you 
will be billed. 
 
If you want information for a single civil case, use the menu options Query or Reports » 
Docket Sheets.

1. Click the Civil Cases link.

The PACER Login page displays.

2. Enter your PACER login and password (see page 3 – 5 for instructions).

After a successful PACER login, CM/ECF displays the Civil Cases Report page.

3. Enter your criteria for generating the report.

4. Click Run Report.
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CM/ECF runs and displays the Civil Cases Report.
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Judgment Index

To run a judgment index report:

1. Click the Judgment Index link.

The PACER Login page displays.

2. Enter your PACER login and password (see page 3 – 5 for instructions).

After a successful PACER login, CM/ECF displays the Judgment Index Report page.

3. Enter your criteria for generating the report.

4. Click Run Report.
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CM/ECF runs and displays the Judgment Index Report.
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Criminal Cases

To run a criminal cases report:

WARNING:  This report queries ALL criminal cases for information that matches your 
criteria. Therefore your criteria could produce many pages of information for which you 
will be billed. 
 
If you want information for a single criminal case, use the menu options Query or 
Reports » Docket Sheets.

1. Click the Criminal Cases link.

The PACER Login page displays.

2. Enter your PACER login and password (see page 3 – 5 for instructions).

After a successful PACER login, CM/ECF displays the Criminal Cases Report page.

3. Enter your criteria for generating the report.

4. Click Run Report.
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CM/ECF runs and displays the Criminal Cases Report.
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Calendar Events

To run a calendar events report:

1. Click the Calendar Events link.

CM/ECF displays the Calendar Events Report page.

2. Enter a date range for the report.

This is the only required input for the report.

3. (optional) Enter remaining criteria as deemed appropriate for your report.

4. Click Run Report.

CM/ECF runs and displays the Calendar Events Report.
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Written Opinions

This report shows you any opinion that has been loaded on the CM/ECF system by the 
Chambers of the District and Magistrate Judges for the Southern District of Texas.

To view a written opinion:

1. Click the Written Opinions link.

CM/ECF displays the Written Opinions Report page.

2. Enter a date range for the report.

This is the only required input for the report.

3. (optional) Enter remaining criteria as deemed appropriate for your report.

4. Click Run Report.
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CM/ECF runs and displays the Written Opinions Report.
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Purpose This chapter provides information on how to access and run the utilities provided 
by CM/ECF.

Chapter Topics The following topics are covered in this chapter:

• Accessing the Utilities, page 7 – 2

• Your Account Utilities, page 7 – 3

• Miscellaneous Utilities, page 7 – 8
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Accessing the Utilities

The CM/ECF utilities provide the means for registered users to maintain their account in 
CM/ECF and to view all of their CM/ECF transactions.

To access the utilities feature:

1. Select Utilities from the menu bar.

CM/ECF displays the Utilities page.

2. Click the link for the utility you want to use.

What displays next depends on the selected utility.
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Your Account Utilities

The links in this section pertain to the user’s CM/ECF or PACER account.

Maintain Your Account

This utility allows you to update your address, phone information, and other personal 
information. 

To use this utility:

1. Click the Maintain Your Address link.

The Maintain User Account page displays.

2. Change any data as required.

3. Click Submit to accept changes.
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View Your Transaction Log

This utility allows you to review all the transactions CM/ECF has processed with your login 
and password. If you believe or suspect someone is using your login and password without 
permission, change your password immediately, then email the Court’s Help Desk as soon as 
possible (page 1 – 2).

To use this utility:

1. Click the View Your Transaction Log link.

The View Transaction Log page displays.

2. Enter the date range for your report.

3. Click Run Report.

CM/ECF displays the Transaction Log of all your transactions within the date range 
you specified.
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Change Client Code

This utility allows PACER users to change the client code, which is used for identifying 
charges made to the current PACER account.

If the user has a PACER preference set (via the PSC website) which requires a client 
code in a specific format, in order to change the client code, you must follow the 
designated format.

To use this utility:

1. Click the Change Client Code link.

The following page displays.

2. Enter a new or changed client code.

3. Click Submit to accept changes.

Change Your PACER Login

This utility allows the user to enter a different PACER login and password.

To use this utility:

1. Click the Change Your PACER Login link.

The PACER Login screen displays.

2. Enter the new PACER login and password.

For details on logging into PACER, see page 3 – 5.

3. Click Login.

CM/ECF displays the message Pacer login stored stating that the change has been accepted.
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Review Billing History

This utility displays the number of CM/ECF pages accessed and the charges incurred for the 
PACER account currently being used. If client codes are entered when CM/ECF is accessed, 
the charges are totaled for each code.

To use this utility:

1. Click the Review Billing History link.

The PACER CASE SEARCH SIGN IN page displays.

2. Enter your PACER login and password.

3. (optional) Enter a client code.

4. Click Login.
7 – 6



CM/ECF Attorney’s User Guide Chapter 7 – The Utilities Menu
Your Account Utilities
The PACER BILLING HISTORY page displays.

5. Enter the date range for your report.

6. (optional) Set other options per your requirements.

7. Click Submit Form.

The BILLING HISTORY report displays.

Show PACER Account

This utility displays the current PACER login ID and client code. To use this utility, click the 
Show PACER Account link.

CM/ECF displays the following:
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Remove Default PACER Account

This utility removes the link between the current CM/ECF user account and the associated 
default PACER account. To use this utility, click the Remove Default PACER Account link.

CM/ECF displays the following:

Miscellaneous Utilities

The links in this section are those that do not pertain to the user’s CM/ECF or PACER 
account.

Internet Payment History

This utility allows users to review the credit card payments made for electronic filing.

To use this utility:

1. Click the Internet Payment History link.

The Internet Payment History page displays.

2. Enter the date range for your report.

3. Click Run Report.

The credit card transactions for the designated time period displays.
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Legal Research

This utility is provided by the Southern District of Texas to the user as a research tool on legal 
matters.

To use this utility:

1. Click the Legal Research link.

The Legal Research page displays.

2. Click the link for the website you want to visit.

Mailings

This utility allows users to find out who receives email notices, who requires manual 
noticing, and to print mailing labels.

To use this utility:

1. Click the Mailings link.

The Mailings page displays.

2. Click the link for the information you need.

Mailing Info for a Case

This link provides a list of people who receive email notices and the people who require 
manual noticing.

1. From the Mailings page, click Mailing Info for a Case.

The Mailing Information for a Case page displays.

2. Enter your case number.
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The Mailing Information for a Case page changes to include a button for finding the 
case.

3. Click Find This Case.

As previously illustrated when filing documents, CM/ECF will let you know if the 
case number is found, not found, or if multiple case numbers match your entry.

The Submit button becomes available after a unique case number is found or after 
you select a case or cases from the matched listing.

4. Click Submit.

The Mailing Information for a Case page displays.
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Mailing Label by Case

This link provides the ability to print mailing labels for a designated case.

1. From the Mailings page, click Mailing Labels by Case.

The Mailing Labels by Case page displays.

2. Enter your case number.

The Mailing Labels by Case page changes to include a button for finding the case.

3. Click Find This Case.

As previously illustrated when filing documents, CM/ECF will let you know if the 
case number is found, not found, or if multiple case numbers match your entry.

The Next button becomes available after a unique case number is found or after you 
select a case or cases from the matched listing.
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4. Make your selections on who should receive labels.

You can:

• Check the All check box.

OR

• Check the Judges and/or Attorneys check box and make selections from the 
Participants drop-down menu. Multiple selections in the Participants drop-
down menu can be made as follows:

• Hold down the Ctrl key and click on individual participants. This allows 
you to make multiple selections not in a continuous range.

• For a continuous range:

• Drag your mouse from the first to the last participant in the range.

OR

• Click the first participant in the range, then go to the last one and hold 
down the Shift key and click the last participant in the range.

5. Select a print format based on printer labels and printer being used.

6. Click Next.

The Search Results page displays. This is the page that should be sent to the printer 
for printing the labels.
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Verify a Document

This utility verifies that the electronic signature of a document is the same as when the 
document was filed. If it is different, the document may have been altered.

To use this utility:

1. Click the Verify a Document link.

The Verify Document(s) page displays.

2. Enter your case number.

The Verify Document(s) page changes to include a button for finding the case.

3. Click Find This Case.

As previously illustrated when filing documents, CM/ECF will let you know if the 
case number is found, not found, or if multiple case numbers match your entry.

The Next button becomes available after a unique case number is found or after you 
select a case or cases from the matched listing.
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4. Enter your document number.

5. Click Next.

The utility verifies the signature on the document and displays the following 
information:

Outcome of verification
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